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Overview 

This document serves as a guide to the frequently asked questions regarding the FTSE PCBond 
Software technical issues. If you encounter any issues, please follow the instructions to 
troubleshoot and resolve them.  

Please reach out to FTSE Fixed Income Index Client Service team at fi.index@ftserussell.com 
for any further questions.  

  

mailto:fi.index@ftserussell.com
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Frequently Asked Questions 

 

Expired Authorization 

Please try to open BondData and see what the error message is, if the message is 

“Authorization has expired”, please provide the PCBond.ath file in your C:\edbro folder to client 

service team to verify your key. 
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Unable to Create Network File/ Unable to Detect Net Lock/Cannot Find 

Hardware Key 

 

Please determine if the issue happens on your workstation or server machine.  

Server machine is usually the machine that runs scnet.exe, if you don’t run scnet.exe at all, then 

it’s a workstation machine. On the server, PCBond will broadcast the license via scnet.exe to a 

shared drive so that all the workstations can use the same license on their own machine by 

searching the shared drive. 

The troubleshooting workflow is outlined below: 

 

For detailed instructions on the above troubleshooting workflow, please refer to pages 7 to 

pages 10 below. 
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Workstation Machine 

If the issue is on your workstation, 

First, please check the drive mapping on the network drive: 

1. Open a normal command prompt, and run "net use". This will display all the network drives 

that are mapped currently. Please make sure their status is “OK” and correct  

2. If it is not mapped, please ask your IT team to map the drive for you 

 

Second, please restart SCNet.exe on the server by doing the following: 

1. On the server, please make sure no users are running pcbond, and quit scent 

2. Delete the (edbro).*  file in the \edbro\ folder in your network drive on the server 

3. Delete the cached key file (edbro).* files in your c:\edbro folder on the server 

4. Delete the obsoleted key (edbro).* file in the \edbro\ folder in your network drive on the 

problematic machine(workstation) 

5. Delete the cached key file (edbro).* files in your c:\edbro folder on the problematic 

machine(workstation) 

6. Re-launch scnet.exe to broadcast the key again 

7. Open Bonddata and Bondman to see if the issue is resolved 

 

Then, please make sure PCBond environment variables (esilock and pcbond) are correct: 

1. Open a normal command prompt, run "set esilock".  

It should look like nodongle,drives:cz or nonet,drives:c.  

C is your local drive, and Z is your network drive. That’s the drive where the PCBond 
program will look for your key. 

2. Within the same command prompt, please run "set pcbond", which should print out a 

directory where the PCBond data will be downloaded to. It should look like C:\PCbond. 

3. If they are not correct, please search “edit the system environment variables” in the search 

bar of the bottom left corner and edit your system variables “pcbond” and “esilock”. 

a. For the “pcbond” environment variable, please ask your team if anyone knows where the 

data will be downloaded to. 

All the data will be downloaded to the /pcbond/data folder. It can either be your local 

drive (i.e. C:) or network drive (i.e. Z:), so please check these drives and look for the 

pcbond/data folder. 

You may also check the date modified of the .dat file in the pcbond/data folder to see if 

the data has been downloaded or updated in this folder recently. 

b. For the “esilock” variable, if this machine is the only machine that is running PCBond 

without relying on any server, the value should be nonet,drives:c (if you install PCBond 

locally on your C drive). If the machine is a workstation, then the value should be 

nodongle,drives:cz (if the network drive is Z). 
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Please note that if esilock is network drive (nodongle,drives:cz), you need to additionally 

check or ask your IT team to check if you have full access right to the Edbro folder on the 

network drive: 

1. Go to Edbro folder on the network drive. If your network drive is Z:, please go to the 

Edbro folder on Z:. You will see a file (EDBRO).* in this folder 

2. Check if this file is in use:  

Please try to rename it to (EDBROBCK).net.  

If you’re unable to rename the file, it means the file is in use which is expected. 

If you can rename the file, it means this file is not in use, then you should check if your 

scnet.exe is running on the server 

3. Check if you have the full access right to this folder:  

Open a command prompt, navigate to (cd /d) the edbro folder on your network drive, run 

“mkdir test” to create an empty test folder, then run “rmdir test” to delete it 

Example: If the edbro folder is in your z drive, do the following in your normal command 

prompt 

a. Cd /d Z:\edbro 

b. Mkdir test 

c. Rmdir test 

If you can create an empty test folder and delete it, it means you have the full access 

right to this folder. 

 

 

Should the aforementioned methods fail, kindly provide the below details to the client 

service team for further investigation: 

1. The screenshot of the error message 

2. Did it work before? When was the last time you were able to run the application without 
issues? 

3. If you haven’t tried it, please go to the FTSE Bond Analytics folder on your desktop and open 

BondData to see if there’s any error 

4. On the machine that you see this error, open a normal command prompt, run the following 

command and take a screenshot: 

a. Set pcbond 

b. Set esilock 

c. Net use 

5. On the machine that you see this error, right click on BondData in your FTSE Bond Analytics 

folder on your desktop and go to properties. Please take a screenshot (make sure to capture 

the Drive Letter in the Target value) 
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Server Machine 

If the issue is on server machine, 

First, please check the drive mapping on the network drive: 

1. Open a normal command prompt, and run "net use". This will display all the network drives 
that are mapped currently. Please make sure their status is “OK” and correct  

2. If it is not mapped, please ask your IT team to map the drive for you 

 

Second, please restart SCNet.exe on the server: 

1. On the server, please make sure no users are running pcbond, and quit scent 

2. Delete the (edbro).*  file in the \edbro\ folder in your network drive on the server 

3. Delete the cached key file (edbro).* files in your c:\edbro folder on the server  

4. Re-launch scnet.exe to broadcast the key again 

5. Open Bonddata/Bondman to check if the issue is resolved 

 

 

Then, please follow the below steps to check the environment variables and access right: 

▪ Make Sure PCBond environment variables (esilock and pcbond) are correct 

1. Open a normal command prompt, run "set esilock". 

It should look like nodongle,drives:cz or nonet,drives:c. 

C is your local drive, and Z is your network drive. That’s the drive where the PCBond 

program will look for your key. 

2. Within the command prompt, please run "set pcbond", which should print out a directory 

where the PCBond data will be downloaded to. 

3. If they are not correct, please search “edit the system environment variables” at the 

search bar of the bottom left corner and edit your system variables “pcbond” and 

“esilock” 

a. For the pcbond envrionemnt variable, please ask your team if anyone knows 

where the data will be downloaded to.  

All the data will be downloaded to the /pcbond/data folder. It can either be your 

local drive (i.e. C: ) or network drive (i.e. Z: ), please check these drives and look 

for the pcbond/data folder.  

You may also check the date modified of the .dat file in the pcbond/data folder to 

see if the data has been downloaded or updated in this folder recently. 

b. For the esilock variable, the value should be nodongle,drives:cz (if the network 

drive is Z). 

 

▪ Check if you have full access right to the pcbond.ath file on the network drive 

1. Open a command prompt, navigate to (cd /d) the C:\edbro folder, and try to rename 

pcbond.ath to pcbond.ath.old.  

If you can run the following commands in the command prompt, it means you have 

access right. 

a. Cd /d c:\edbro 
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b. Rename pcbond.ath pcbond.ath.old 

c. Rename pcbond.ath.old pcbond.ath 

 

If you cannot do it, it means you do not have the access right to the PCBond license key 

2. Try to delete any (EDBRO).* in this folder. If you can delete, it means you have access 

right. 

 

▪ Check or ask your IT team to check if you have full access right to the Edbro folder on the 

network drive 

1. Go to Edbro folder on the network drive. If your network drive is Z:, please go to the 

Edbro folder on Z:. You will see a file (EDBRO).* in this folder 

2. Check if you have the full access right to the folder:  

Open a command prompt, navigate to (cd /d) the edbro folder on your network drive, run 

“mkdir test” to create an empty test folder, then run “Rmdir test” to delete it. 

Example: If the edbro folder is in your z drive, do the following in your normal command 

prompt 

a. Cd /d Z:\edbro 

b. Mkdir test 

c. Rmdir test 

If you can create an empty test folder and delete it, it means you have the full access 

right to this folder. 

 

If the above steps work and you can run scnet in admin mode, it means you probably 

miss the access right to the registered key in the registry. Please do the followings: 

1. Please open the Registry Editor by searching it at the search bar at the bottom left corner. 

2. Please go to the path of the registered key: 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\PCBond\PCBond 

Suite\  

3. Please right click on the “PCBond Suite” folder, go to Permissions, and change the 

permission to have full control access to the folder. 

If the above steps don’t work, please proceed with the following: 

1. Please open an admin command prompt. 

2. Run “set pcbond” and “set esilock” to see if they are set, if not, set them accordingly (i.e. set 

pcbond=C:\pcbond and set esilock=nodongle,drives:CZ). 

3. Run “net use” to see if the drive has been mapped. 

If not, please run “net use” in the normal command prompt, then copy the drive mapping to 

the admin command prompt by running “net use” in the admin command prompt. 

Example: “net use g: \\abc\def” 

4. In the admin command prompt, please navigate to the scnet or bonddata folder and try to 

launch scnet or bonddata again. For example, 

a. Cd /d Z:\PCBond\binw 

b. bonddata 
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Should the aforementioned methods fail, kindly provide the below details to the client 

service team for further investigation: 

1. The screenshot of the error message 

2. Did it work before? When was the last time you were able to run the application without 
issues? 

3. If you haven’t tried it, please go to the FTSE Bond Analytics folder on your desktop and open 

BondData to see if there’s any error 

4. On the machine that you see this error, open a normal command prompt, run the following 

command and take a screenshot: 

a. Set pcbond 

b. Set esilock 

c. Net use 

5. On the machine that you see this error, right click on BondData in your FTSE Bond Analytics 

folder on your desktop and go to properties. Please take a screenshot (make sure to capture 

the Drive Letter in the Target value) 
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PCBond Add-ins Issues 

Excel Settings Check 

1. Start normal excel 

2. Go to file → Account and check excel version is 32-bits. Please note that PCBond only 

works on a 32-bits excel. 

3. Check all the excel security settings. Go to File → Options → Trust Centre. 

4. In Trusted Locations, please add the server drive i.e. Z:\PCBond (or Local drive like C if 

you’re running Bondman locally. You can go to your FTSE Analytics Bond folder on your 

desktop, right click on Bond Manager, go to properties, check target and look for 

“c:\pcbond\binw” to see where it runs from.)  

Please check the option [subfolders of this location are also trusted] and [allow 

trusted locations on my network box]. 

5. In ActiveX settings, enable all controls without restrictions. 

6. In Macro settings, enable all macros and check the option Trust access to the VBA. 

7. Please try start Normal Excel → File → Options → Add-ins → Select “Disabled Items” at the 

manage menu → Go and ensure there are no PCBond .xla files, and all the 

bondmanager.xla add-ins are on the add-in list. 
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MISSING XLA 

 

 

To resolve the Bond Manager error, please do the following: 

1. Please make sure your excel is 32-bits 

2. Please open BondData and send us a screenshot if there’s any error 

3. Please start Normal Excel → File → Options → Add-ins → Select “Disabled Items” at the 
manage menu → Go and ensure there are no PCBond .xla files 

4. Go to your FTSE Analytics Bond folder on your desktop, right click on Bond Manager, and go 
to properties, check the Drive Letter of \pcbond\binw in the Target value 

5. Please go to Drive:\pcbond\binw (Drive will be the Drive Letter from step 4), run install.xls and 
follow the instructions to install the xla again. Click No if it prompts you copy or add xla files 

6. Open a normal command prompt and run the “Net Use” to make sure the network drive is 
mapped 

7. Please try to run Bondman as admin 
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Errors in Loading .ocx File / ocx Registration 

If you see the error in loading .ocx file or the module .ocx file was loaded but the call to 

DllRegisterServer failed with error code, please do the followings:  

1. Please register the ocx files by going to the c:\edbro and run bondmanpopup.bat 

2. If it doesn't work, copy securityselect.ocx, cfx4032.ocx and sfxbar.dll from /pcbond/BINW 

to C:/edbro 

3. Open an admin command prompt, run the following commands  

a. Go to your edbro folder in C drive (cd /d c:\edbro) 

b. regsvr32.exe securityselect.ocx 

c. regsvr32.exe  cfx4032.ocx 

4. If you got the access denied error while registering the .ocx file, please run Regsvr32.exe 

with the full path of the .ocx file 

5. Please try to launch bonddata and bondman 
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Compile Error in Hidden Module 

 

1. Make sure your excel is 32-bits 

2. Please open BondData and send us a screenshot if there’s any error 

3. Ensure the .ocx is registered (Please refer to the ocx registration) 

4. Right click on BondManager in your FTSE Bond Analytics folder on your desktop, go to 
properties, and check the Drive Letter of \pcbond\binw in the Target value (For Example: 
C:\pcbond\binw) 

5. Open edit system environment variables dialog by searching it at the bottom left corner, and 
add Drive:/pcbond/BINW folder path (Drive will be the Drive Letter from step 4) to the path 
variable  

6. Please do the Excel setting check (Please refer to page 12) 

7. If the above steps still do not work, please provide the below information to client service 
team 

a. Take screenshot of Drive:/pcbond/BINW folder (Drive will be the Drive Letter from step 
4) 

b. Open a command prompt, run the following commands and take a screenshot 
▪ Cd /d Drive:/pcbond/bin (Drive will be the Drive Letter from step 4) 
▪ whatver Drive:/pcbond/binw/bondman.dll (Drive will be the Drive Letter from step 4) 

c. Open a powershell, run the following commands and take a screenshot 
▪ Get-FileHash Drive:/pcbond/binw/bondman.xla (Drive will be the Drive Letter from 

step 4) 
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Errors in Restoring Print Page Layout When Running Macro  

1. Please install and set a default printer to run this 
2. If you don’t have one, please set it to print to PDF as below picture 
3. Open bondmanager. Go to File, click Print and make sure a printer is selected 
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JRE Error when Running the Download Script 

JRE download is no longer use in PCBond download. Please check the output of the download 
script to see the version of FTPComm.  

If it’s not v8.0b, please send a screenshot to client service team 
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Download Issue or Unable to Connect to MyData 

1. Please open https://www2.yieldbook.com/x/mydata_locator3 from browser to test the 
connection to myData UAT 

 
2. Please ensure your Powershell version is version 5.1 or later. You can check the Powershell 

version by doing the following steps: 
a. Create a new folder called “check_ps_version” under your C drive or any drive you 

want 
b. Open a normal command prompt. If you create the folder in your C drive, run “cd /d 

C:check_ps_version” to navigate to the new folder you create 
c. Run “notepad psversion.ps1” to create a powershell script 
d. Copy the following lines to the script you just create 

$ver=5.1 
 write-Host "Powershell version "$PSVersionTable.PSVersion "installed." 
 if ($PSVersionTable.PSVersion -lt $ver) { 
         write-Host "Require Powershell version $ver or later." 
 } 

e. Save and close the script 
f. In the same command prompt, run the below command 

"C:\Windows\SysWOW64\WindowsPowerShell\v1.0\powershell.exe"  -NonInteractive -
executionpolicy bypass -F .\psversion.ps1 

Example: 

 

 

  

https://www2.yieldbook.com/x/mydata_locator3
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Over Night Download 

Please follow the below steps: 

1. Close the download window (if any) 

2. If there are any *.pcb files in \pcbond\data\download\, please delete them 

3. Delete \pcbond\mail\Canadian universe bond index summary.xls 

4. Run the download script from a command prompt and capture any messages displayed 

Please ensure there were no network changes on your end. 

Further, please ensure your anti-virus is not scanning .pcb files. 
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When I Open BondData but Nothing Happened 

Please do the followings on the problematic machine 
1. Open a normal command prompt and run “set pcbond”, it will display the folder that PCBond 

will download the data to. 

 

2. In the screenshot above, the data will be downloaded to C:\pcbond 
3. Go to C:\pcbond and check if there’s a Data folder. Go into Data folder and check if it 

contains either Daily_A.dat or Daily.dat file.  
If not, it means your database hasn’t been installed, please take a screenshot and provide to 
client service team 

4. If you do see the file in the pcbond\data folder, please launch Bond Manager from your 

FTSE Bond Analytics folder on your desktop. If you are able to launch it, please open a 

normal command prompt and run 

a. Set bonddata_ini 

5. If you see bonddata_ini is not defined, please add an environment variable by search “edit 

the system environment variables” in the search bar of the bottom left corner, click 

Environment Variables, and add bonddata_ini with value c:\edbro to your system variables. 

Then please run BondData again 

6. If you see the bonddata_ini has been defined, please go to your C:\edbro folder and look for 

the bonddata.ini file, rename it to bonddata_backup.ini, and run BondData again 
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Excel Cannot Open the File ‘BM2000.xltm’ 

1. Go to your FTSE Analytics Bond folder on your desktop, right click on Bond Manager, and 
go to properties, check the Drive Letter of \pcbond\binw in the Target value 

2. Open a Powershell, run the below script (Drive is taken from step 1) to check the access 
right, take and send a screenshot to client service team 

Get-FileHash Drive:\pcbond\binw\bm2000.xltm 
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Other Issues 

If your issue is not in the one of the above issues, please prepare the following information 

1. What are you trying to do? Are you trying to run the download script to download the data or 
trying to run BondMananger etc.? 

2. The screenshots and the description of the error 
3. Is the error happening on the server machine or workstation machine? (Server machine is 

the machine that runs SCNet, if you’re not running it on that machine, then it’s a workstation 
machine) 

4. The steps/actions that the user performed which led to this error 
5. Did it work before? When was the last time you were able to run the application without 

issues? 
6. If you haven’t tried it, please go to the FTSE Bond Analytics folder on your desktop and 

open BondData to see if there’s any error 
7. On the machine that you see this error, open a normal command prompt, run the following 

command and take a screenshot: 
a. Set pcbond 
b. Set esilock 
c. Net use 

8. On the machine that you see this error, right click on BondData in your FTSE Bond Analytics 
folder on your desktop and go to properties. Please take a screenshot (make sure to capture 
the Drive Letter in the Target value) 

9. On the machine that you see this error, right click on BondManager in your FTSE Bond 
Analytics folder on your desktop and go to properties. Please take a screenshot (make sure 
to capture the Drive Letter of \pcbond\binw in the Target value) 

10. On the machine that you see this error, if you can open Bond Manager, go to Add-ins → 
Help → About BondManager to see the version of Bondman you’re running and take a 
screenshot 

11. If it’s macro-related issue, please provide all the .mb6 files and press Windows + R → 
%temp%, then provide the bmmacro.log file 

12. If it’s download-related issue, please take a screenshot of your \pcbond\data folder (make 
sure to capture the “Date Modified” attribute) 

13. If it’s download-related issue, please try to launch the download.bat in command prompt to 
capture any messages and take a screenshot, and provide the FTPComm.log, SMIError.log, 
and WhoAmI.pcb files in your \\pcbond\log\ directory  
 

Please attach all the required screenshots, log, files in the above steps and provide to client 
service team for further investigation
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ABOUT FTSE RUSSELL 

FTSE Russell is a leading global provider of index and benchmark solutions, spanning diverse asset classes and investment objectives. As a trusted 

investment partner we help investors make better-informed investment decisions, manage risk, and seize opportunities. 

Market participants look to us for our expertise in developing and managing global index solutions across asset classes. Asset owners, asset 

managers, ETF providers and investment banks choose FTSE Russell solutions to benchmark their investment performance and create investment 

funds, ETFs, structured products, and index-based derivatives. Our clients use our solutions for asset allocation, investment strategy analysis and 

risk management, and value us for our robust governance process and operational integrity. 

For over 35 years we have been at the forefront of driving change for the investor, always innovating to shape the next generation of benchmarks 

and investment solutions that open up new opportunities for the global investment community. 

 

CONTACT US 

To learn more, visit lseg.com/ftse-russell; email fi.index@ftserussell.com; or call your regional Client Service team office: 

North America  

+1 646 989 2122 

+1 416 572 7979 

EMEA                              Tokyo  

+44 20 7797 1003            +81 3 6441 1440 

 

 

 

 

 

http://lseg.com/en/ftse-russell
mailto:fi.index@ftserussell.com

